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Chapter 21:  Managing Abstracting Assignments 

Casefinding or abstracting assignments are maintained and tracked in SEER*DMS as Abstract 

Facility Leads (AFLs).  As a record or patient set is processed, an AFL is auto-created if SEER*DMS 

detects, per registry-defined algorithms, that further information must be abstracted from medical 

records.  SEER*DMS also allows ad hoc AFLs to be created manually, for example, to initiate a lead 

based on a phone conversation with a facility’s representative.   

An AFL is closed automatically when an abstract record enters the system that matches the AFL 

based on registry-defined criteria.  SEER*DMS will also review all open AFLs related to a patient 

each time a patient set is saved.  Each AFL created by a record linked to the patient set will be 

reviewed.  The AFL will be auto-closed if the AFL’s source record meets criteria defined by the 

registry.  The auto-close rules used in your registry are documented on the AFL help page (select 

AFL from the help menu). 

Several system reports are available in SEER*DMS to monitor casefinding completeness.  If you 

determine a case should be submitted to SEER or other sources as a Death Certificate Only (DCO)  

or Casefinding Only (CFO) case, you may build a CTC from the record (see Creating a CTC from a 

Non-abstract Record for more information). 

In this chapter, you’ll learn about 

 Relevant Terms 

 Understanding Abstract Facility Leads in SEER*DMS 

 Abstract Facility Leads Created in Automated Tasks 

 Manually Creating an Abstract Facility Lead  

 Assigning Leads to an Abstractor 

 Tracking Abstracting Assignments 

 Printing AFLs 

 Updates to AFL Data Fields 

 Modifying AFLs 

 Creating a CTC from a Non-abstract Record 

 Casefinding Reports 

Relevant Terms 

The following terms will be used throughout this chapter: 

Abstract Facility Lead (AFL) 

In SEER*DMS, an AFL is a mechanism for assigning and tracking a request to abstract a 

case.  The processes to create, track, and close AFLs are described in this chapter. 

 

Casefinding Record 

A record submitted to the registry containing medical data from pathology reports.  These 

data may indicate a new case or identify the need for an abstract related to an existing 

case.  Therefore, an incoming Casefinding record often triggers the creation of an Abstract 

Facility Lead.  If an abstract is never obtained, a new CTC can be built from a Casefinding 

record (see the Creating a CTC from a Non-abstract Record section of this chapter).  The 

specific file types that are processed as “Casefinding” in the workflow are listed on your 

registry’s workflow diagram.  For example, HL7, and other import file types may contain 

casefinding data and follow the workflow path defined for Casefinding Records.  
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Health Index Record 

A record type that is typically used to store data from a hospital’s diagnostic index records 

or discharge logs.  These data are used for quality assurance related to casefinding; and 

may provide follow-up and treatment data that are consolidated into existing patient sets.  

If a Health Index record indicates the need for an abstract, an AFL is auto-created. 

 

NAACCR Update Record 

The NAACCR short format record used to submit field-specific corrections to data previously 

submitted to the registry.  If a NAACCR Update record cannot be matched to a CTC, an 

abstract facility lead is auto-created. 

 

Death Certificate Record 

A data record containing death certificate data items.  These data are used to update follow-

up variables for existing patient sets.  If a death certificate indicates a new reportable 

cancer, an AFL is created.  If an abstract can not be obtained, death clearance follow-back 

procedures are performed as described in Chapter 17:  Death Clearance. 

 

Short Health Record 

A record type used by some registries that contains medical data, but is not a complete 

abstract.  Typically, these records provide additional information regarding follow-up, 

treatment, and admissions related to a previously abstracted case.  An AFL may be auto-

created if an abstract record is not linked to the same CTC as the short health record.  Short 

health record is the only record type that is used for both AFL auto-creation and AFL auto-

close algorithms.   The exact algorithms vary by registry and are described on the AFL help 

page (select AFL from the Help menu). 

Understanding Abstract Facility Leads in SEER*DMS 

The following describes the overall process for assigning and tracking abstract facility leads (AFLs).   

1. AFLs are created:   Typically, AFLs are created in automated processes as Casefinding, 

Health Index, NAACCR Update, Short Health, or Death Certificate records move through 

the workflow (a general description is provided in the Abstract Facility Leads Created in 

Automated Tasks section of this chapter; refer to the AFL help page or your registry’s 

workflow diagram for the exact algorithms used in your registry).  An AFL may also be 

created manually (see the Manually Creating an Abstract Facility Lead section of this 

chapter). 

2. AFLs are assigned to an abstractor:  A registry casefinding manager uses SEER*DMS 

to create a list of AFLs which can be assigned to an abstractor, in the form of the 

“Abstracting Assignments” report (see the Assigning Leads to an Abstractor section of this 

chapter).  AFLs must be assigned in a group for a single facility.  The “Abstracting 

Assignments” report is printed by clicking the Assignments button in the Abstract Facility 

Lead manager (see the Printing AFLs). 

3. Medical records are abstracted:  The abstractor investigates each assigned lead and 

indicates any action taken by writing the appropriate code on the “Abstracting 

Assignments” report.  The action codes may be used to track the “result” of the 

abstracting assignment.  The coding scheme includes codes indicating reasons for not 

abstracting a case and a code to indicate that an abstract was obtained. 

a. The abstractor uses the registry’s abstracting tool to create an abstract record for each 

reportable case.  Records for the abstracted cases are imported into SEER*DMS.    
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b. The abstractor returns the assignment report to a casefinding manager; a reason 

should be indicated for each case that was not abstracted.  

4. AFLs are automatically closed when abstract records are imported:  Imported 

abstract records move through the workflow.  If an abstract record matches an AFL, the 

lead is closed automatically.  Refer to the AFL help page or your registry’s workflow 

diagram for the exact algorithms used in your registry. 

5. AFLs that remain open are reviewed and processed.  The AFLs may be manually 

closed, flagged for further investigation or physician letters, or reassigned:   

a. Registry staff use SEER*DMS to manually close AFLs that are no longer needed.  This 

would include leads that were satisfied by an abstract but were not recognized as a 

match based on the AFL matching algorithm (e.g., if data fields were missing or 

incomplete), as well as leads that refer to non-reportable events.  The abstractor’s 

determination (“not a reportable cancer”, “not at hospital”, etc) may be indicated in the 

AFL’s result field.   

b. A casefinding manager reviews the “Abstracting Assignments” report returned by the 

abstractor.  There may be leads that still require an abstract, for example, if the 

medical records were not available for abstracting.  The “Abstracting Assignments” 

report can be reprinted for this group (see the Printing AFLs section of this chapter).  

The casefinding manager either re-assigns the pending leads to an abstractor; or 

ungroups the leads to allow them to be re-assigned at a later time. 

c. The result field may also be used to designate and track open AFLs for which an 

abstract could not be obtained and require further investigation.  For example, when it 

is determined by the abstractor that the information is based on a pathology report and 

the patient was not seen at the facility, a casefinding manager may set the result of the 

lead to Tissue Only.  This indicates that an abstract is not required from the facility 

associated with the AFL; the registry may need to investigate the case further to 

determine whether an abstract is required from another facility or doctor’s office. 

d. A casefinding manager uses import reports and the Abstracting Assignments report to 

investigate AFLs that were abstracted but did not match imported abstract records (as 

determined by the matching algorithm described in the Algorithms to Auto-close AFLs 

section of this chapter). 

You may use an AFL’s result field to record the determination coded by the abstractor on the 

Abstracting Assignments report.  The valid values for this field are listed below.  Registry policies 

should determine how this field is populated and maintained.  In SEER*DMS, the Abstracted and 

Not a Reportable Cancer values involve special processing as noted below. 

 Abstracted – When an abstract record is imported into SEER*DMS, the AFL is closed and 

the result field is automatically set to abstracted.   

 FUP Only  

 Not a Reportable Cancer – If a closed AFL has a result value equal to “Not a Reportable 

Cancer”, the reportability of the record that triggered the AFL is changed to auditable. 

 Tissue Only   

 Slide Only   

 Not at Hosp 

 DOA 

 Rad Only 

 Recurrence 
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 Metastatases 

 Duplicate 

 Out of Area 

 Prior to Reporting Date 

 Consultation Only 

 History Of 

 Other 

Abstract Facility Leads Created in Automated Tasks 

An AFL is auto-created when SEER*DMS determines, per registry-defined algorithms, that further 

information must be abstracted from medical records.  In general, an AFL is auto-created if there is 

an indication that a facility has diagnosed or treated a patient for cancer but an abstract record was 

not received.  The following summarizes events that trigger the auto-creation of an AFL.  The exact 

algorithms used for your registry are described in the Auto-create Rules section of the AFL help 

page (select AFL from the help menu). 

Workflow 

Auto-create AFL is an automated task in the workflow.  This task creates an AFL if the 

incoming record meets specific criteria defined by the registry.  These criteria are 

documented on the AFL help page (see the workflow section of the Auto-create Rules). 

Patient Set Updates 

Rules to auto-create AFLs are applied each time a patient set is saved.  For example, there 

may be a rule to create an AFL if the patient set is saved with a NAACCR update record that 

is linked at the patient level but contains CTC-related data.   

If auto-create rules for patient updates are defined for your registry, they will be 

documented on the AFL help page.  

 

Final Review of Patient Set Data 

The final process in the SEER*DMS workflow involves automated checks of the patient set 

data.  For example, the treatment fields may be checked to determine if additional 

information is required.  If this rule exists for your registry, SEER*DMS would create an AFL 

if data in the patient set indicates that a treatment was performed at a facility, yet the 

abstract record was not received. 

If auto-create rules for the final patient set review are defined for your registry, they will be 

documented on the AFL help page.  

Manually Creating an Abstract Facility Lead 

Requires system permission:  afl_initiate 

Information obtained via paper records or ad hoc communications with a facility can be used to 

create an Abstract Facility Lead (AFL) manually.  You should search the database to verify that this 

case was not previously abstracted.  SEER*DMS applies a matching algorithm to prevent duplicate 

AFLs from being created (see Matching Algorithm on the AFL help page). 

 

To manually create an AFL in SEER*DMS: 

1. Select View > Patients. 

2. Enter all known patient information in the search fields. 
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3. Do not restrict the search by Data Type.  You may either use the default setting for this 

field (nothing is selected) or select both Patient Sets and Unlinked Records. 

4. Click Search.  Follow the next step that is appropriate based on the search results. 

If you did not find the person in the database, i.e., there are no Patient Sets or records that match: 

1. Click Create AFL on the Patient Lookup page. 

2. The information that you entered to search the database will be auto-filled in the AFL 

page.  Use the  lookup to enter the reporting Facility. 

3. Fill in as many of the fields as are known.  If the data are available, it is particularly 

important to enter medical record number, first and last name, date of birth, social 

security number, and event date (date of service).  SEER*DMS uses these fields to match 

AFLs to incoming abstract records.  Matched AFLs are automatically closed (see the 

Algorithms to Auto-close AFLs section of this chapter). 

4. Click OK. 

If you find a record for this person, check to see if it fills the casefinding need: 

1. Click the Record ID. 

2. Compare the casefinding information to the record’s data.  

a. Is this the same person?  Check name, date of birth, SSN, and other identifiers. 

b. Is this the same tumor?  Check site and compare the record’s admission date to the 

casefinding event date. 

c. Is the record’s reporting source the same as the facility noted in the new information?    

3. If you determined that this is an abstract record related to this casefinding information, 

there is no need to create a new AFL.  You are finished processing this casefinding lead 

and can either click Cancel to return to the Patient Lookup or use the menus or toolbar to 

access other parts of SEER*DMS.   

4. If you determine that the record is not an abstract related to this casefinding lead: 

a. Click Cancel to return to the Patient Lookup page. 

b. Click the Create AFL button on the Patient Lookup page.   

c. Information that you entered to search the database will be auto-filled in the AFL page.   

d. Fill in as many of the fields as are known.  It is particularly important to enter all known 

information for medical record number, first and last name, date of birth, social security 

number, and event date.  SEER*DMS uses these fields to match AFLs to incoming 

abstract records.  Matched AFLs are automatically closed (see the Algorithms to Auto-

close AFLs section of this chapter). 

e. Click OK. 

If you find a Patient Set for this person, check to see if an abstract record that fills this casefinding 

need exists and is linked to the Patient Set: 

1. Click the Patient Set ID.   

2. Using the CTC links in the Patient Set navigation box, review each CTC.   
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3. If this casefinding lead is a report from a new facility for an existing CTC: 

a. Click the appropriate CTC link to select it (CTC 00 is selected in the figure below). 

b. Click the  menu indicator next to Patient ID to open the CTC menu.  Select Add AFL. 

 

c. Information from the CTC will be auto-filled into the AFL form.  Review these fields and 

make changes, as necessary.  The Event Date is auto-filled with the date of diagnosis 

for the CTC.  If the new information includes a more appropriate date, revise this field. 

d. Complete as many additional fields as are known.  You must specify a Facility. 

e. Click OK. 

If this casefinding lead represents a new CTC for this patient: 

1. Click the Demographics link in the Patient Set portion of the navigation box.  (To verify 

this, check to see that Demographics is shown on a shaded background.) 

2. Click the  menu indicator next to the Patient ID.  The Patient Set Demographic’s menu 

will be displayed. 

3. Select Add AFL. 

4. Demographic information from the patient set will be auto-filled into the AFL form.  Review 

these fields and make changes, as necessary.    

5. Complete as many additional fields as are known.  You must specify Facility Name.  

6. Click OK. 

Once you save the new AFL, it will be added to the system as an open, unassigned AFL.  Use the 

AFL Manager to assign this lead to an abstractor.  

Assigning Leads to an Abstractor 

Requires system permission:  afl_manager 

AFLs must be grouped by facility before they can be assigned to an abstractor.  A group may 

consist of one or more AFLs for a single facility.  If the number of AFLs for a facility is too large to 

assign, smaller groups based on event date should be created.  Event date is the date of diagnosis 

(if available), report date (Casefinding records), date of last contact (Death Certificates), admission 

date (Health Index records, these would typically be diagnostic index records) or the date of 

service entered into the Event Date field when the AFL was manually created.  
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To assign a set of AFLs to an abstractor: 

1. Select Manage > Abstract Facility Leads.     

2. Use the Filter controls to reduce the list: 

a. You may limit your selection by the type of record that triggered the AFLs.  For AFLs 

related to Casefinding records, select Casefinding in the Source filter.  For AFLs related 

to death clearance processes, select Death Cert. 

b. Click Open in the Status filter to make it the only value selected in the filter.  

c. Use the  lookup to select the facility in the Fac ID filter. 

d. If your registry manages data for multiple regions, you may select a value in the 

Region filter. (The filter is not displayed if only one region is defined for the registry). 

e. If you would like to exclude AFLs which were previously grouped and assigned to an 

abstractor, check Exclude Grouped. 

f. If an AFL was assigned to and reviewed by an abstractor, the determination made by 

the abstractor may be listed in the Result field.  To select based on this field, select an 

appropriate value for the Result filter.  You may multi-select in this filter. 

g. Click Apply.  The open AFLs for the selected facility and record type will be shown.   

The number of AFLs will be displayed at the top left.  Determine if this is an appropriate 

number of AFLs to print and assign.   

h. If the number of AFLs is too large for one assignment, you may either continue with 

step 3 and then limit the number to be modified; or you may create a smaller list by 

filtering on event date.  You may specify a closed or open-ended date range using one 

or both of the Event Date filters.   

i. To select AFLs with an event date on or after a particular date, enter the date in 

Event From. 

ii. To select AFLs with an event date prior to and including a particular date, enter 

the date in Event To. 

iii. To include AFLs within a specified range of years but with unknown month and/or 

day, check the month and/or day boxes in the Show unknown dates section.   

iv. To include AFLs with unknown year, check the year box in Show unknown dates 

section.    

v. To review a list that only includes AFLs with unknown event dates, enter a future 

date in Event From and check the year box in the Show unknown dates 

section. 

3. Review the AFLs that are displayed.  If an AFL has a group ID, the AFL may have 

previously been assigned to an abstractor.  Determine if you wish to assign the AFL in a 

new group before continuing.    

4. To assign all AFLs that are listed or a subset of those AFLs, click Modify All.  You will be 

able to specify the number of AFLs in a later step.  To assign a specific set of AFLs, check 

the box to the left of each AFL ID and click Modify (you can only check the boxes of AFLs 

that are on the same page). 

a. If you wish to limit the number of AFLs assigned in this group, enter a value in the 

Maximum Number to Modify field. 
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b. Set Group Action to Group. 

c. Click OK to exit the Modify AFLs page.   

d. You will be prompted to confirm that you wish to create a new group containing the 

AFLs.  Click OK.  A new Group ID will be assigned to each AFL. 

5. To create an Abstracting Assignments listing for the new group, click Assignments.  A 

configuration setting defined by registry management determines whether this listing will 

be presented as a printable PDF report or written to a CSV file that can be opened in Excel. 

a. Depending on your browser settings, you may have the option to Open or Save the 

listing.  If so, click Open.   

b. If the listing is in PDF format, it will open in an Adobe Acrobat window.  If it is in CSV 

format, it will open in Excel. 

c. Use the Adobe or Excel controls to print and/or save this report.  To print, you may 

need to use a printer that allows you to use 11x17 inch paper and select the correct 

paper size in Print Setup (specific instructions vary depending on your printer and the 

version of the printer driver that is installed, please contact your IT staff for further 

instructions). 

Tracking Abstracting Assignments 

Requires system permission:  afl_manager 

To track and update the status of leads assigned to an abstractor: 

1. Collect the Abstracting Assignments report from the abstractor.  The Action column of the 

report should contain a code indicating that the case was abstracted or the reason it was 

not abstracted.    

2. Consult your IT staff to ensure that the abstract records submitted with the report were 

imported into SEER*DMS.  It is important to wait for the records to be imported and 

processed in order to allow SEER*DMS to automatically close as many leads as possible.  

You will only need to update the leads that did not match abstract records.  

3. Click Manage > Abstract Facility Leads. 

4. Enter the Group ID printed on the Abstracting Assignments report into the Group ID filter.  

Tip:  If you are viewing a list of AFLs, the Group ID filter is set automatically when you 

click the Group ID of one of the AFLs. 

5. Set the Status filter. 

a. If you wish to limit your review to pending AFLs in this group, set the Status filter to 

Open.  AFLs in the group will not be listed if they were auto-closed when a matching 

abstract record was loaded and processed.  The number of items now displayed in 

SEER*DMS should be less than the number of AFLs in the printed report.  If this is not 

the case, consult your IT staff to determine if the abstract records were imported. 

b. Typically, you will only need to review and modify AFLs that remain open to determine 

if further processing is required or to indicate the reason that an abstract was not 

obtained.  However, if you wish to review all AFLs in the group, set the Status filter to 

blank.  The list should include all AFLs that were assigned and printed on the report.  

However, it is possible that some AFLs were ungrouped or re-assigned in another group 

(you may search for a specific AFL by AFL ID, if necessary).   
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6. Click Apply. 

7. As determined by registry policies and procedures, you may use one of the following 

methods to process AFLs that were not auto-closed during the processing of the imported 

records.  If you wish to document a change to an AFL, process each AFL individually.  

Otherwise, you may implement these changes on a set of AFLs that you select (steps for 

selecting sets of AFLs are discussed in the Modifying AFLs section of this chapter). 

a. If an abstract is not necessary or cannot be obtained, set the result field to the 

appropriate value and close the AFL.  Note:  If you set result to Not a Reportable 

Cancer, the record that triggered the AFL will be changed from reportable to auditable. 

b. To request an abstract from a different facility, use the  lookup to specify an ID in the 

Facility field.  The AFL will be removed from the current group.  Follow the instructions 

in Assigning Leads to an Abstractor to add the AFL to a new group. 

c. To submit a new request for an abstract from the same facility, you may either ungroup 

the AFL to allow it to be considered for a new group created at a later time; or you may 

move a set of AFLs from this group to a new group by setting Group Action to Group.  

d. If an abstract record is expected but the data file has not yet been loaded, do not 

modify the AFL.  Consult your IT staff to determine when the data will be loaded.  

Printing AFLs 

Requires system permission:  afl_manager 

The AFL Manager includes two buttons for printing reports.  The Print button generates a report 

(RPT-073A) showing the AFLs currently listed in the AFL manager.  The data in this report are the 

same as those displayed in the AFL Manager, it includes all pages.  The Assignments button can 

be used to generate the Abstracting Assignments sheet (RPT-XX013A, where XX is a code 

indicating the registry).  The layout of this report is registry-defined; and it can only be used to 

generate an assignment sheet for AFLs in the same group.  

To print AFLs: 

1. Click Manage > Abstract Facility Leads. 

2. Use one or more of the filter fields to select the AFLs to include on the report: 

a. To include both open and closed AFLs in the report, set the Status filter to blank.  

Otherwise, select a value for this filter.  

b. To print AFLs for a single facility, use the  lookup to specify an ID in the Facility filter.   

c. If your registry manages data for multiple regions, you may use the Region filter to 

limit the list.  (This filter is not displayed if only one region is defined for your registry.) 

 

d. If you are printing AFLs from a single group and know the Group ID, enter the ID in the 

Group ID filter.  To enter multiple IDs, click the   adjacent to the filter.  You may 

then type multiple IDs into the text box. 

e. To print a set of AFLs based on event date, you may specify a closed or open-ended 

date range using one or both of the Event Date filters.   
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i. To select AFLs with an event date on or after a particular date, enter the date in 

Event From. 

ii. To select AFLs with an event date prior to and including a particular date, enter 

the date in Event To. 

iii. To include AFLs within a specified range of years but with unknown month and/or 

day, check the month and/or day boxes in the Show unknown dates section.   

iv. To include AFLs with unknown year, check the year box in Show unknown dates 

section.    

v. To review a list that only includes AFLs with unknown event dates, enter a future 

date in Event From and check the year box in the Show unknown dates 

section. 

3. Click Apply.   

4. Create a PDF report file listing the AFLs currently displayed: 

a. To create a report containing the fields currently shown on your screen, click Print.   

b. To print the Abstracting Assignments report for a single group, click Assignments.  

This report cannot be generated for AFLs that are not grouped or for AFLs that are in 

multiple groups.   

5. Depending on your browser settings, the report may open automatically or you may need 

to click Open. The PDF will open in an Adobe Acrobat window. 

6. Use the Adobe controls to print or save this report. 

7. Close the Adobe window. 

Updates to AFL Data Fields 

Requires system permission:  afl_manager 

When an AFL is created, the data fields from the source record or patient set are copied into fields 

in the AFL.  If the record data fields are modified, the data fields in the associated AFL are 

automatically updated.  However, the reverse is not true.  If you modify the data fields in the AFL, 

the fields in the source record are not changed.  The only situation in which the record is changed 

due to a change in an AFL occurs when an AFL is closed with a result of Not a Reportable Cancer.  

In this situation, the reportability of the record is changed to auditable. 

Modifying AFLs 

Requires system permission:  afl_manager 

After following the steps in Tracking Abstract Assignments, you may wish to modify the Status, 

Result, Grouping, or Letter flag of an AFL.  Status indicates whether the AFL is opened or closed.  

The Result field is used to track the final determination made by the abstractor when they 

attempted to abstract the case.  Typically, this field is used to code the reason given for not 

obtaining an abstract.  The Grouping Status of an AFL may be changed to ungroup an AFL or assign 

it to a new group.  In addition, you have the ability to set a flag that indicates whether a letter is 

needed.  This flag is not used by SEER*DMS but may be referenced by an external report to create 

letters requesting additional information from a physician or reporting facility.   

If you wish to document a change to an AFL, process each AFL individually.  Otherwise, you may 

implement these changes on a set of AFLs that you select.   
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To modify a single AFL or a set of AFLs: 

1. Click Manage > Abstract Facility Leads. 

2. Use the filters to search for the AFLs that you wish to modify. 

a. To include both open and closed AFLs in the search, set the Status filter to blank.  

Otherwise, select the appropriate value for this filter.  

b. To search for an AFL group, enter the Group ID printed on the Abstracting Assignments 

report into the Group ID filter. 

c. To specify a set of AFLs by ID, enter the IDs into the AFL ID(s) or Pat/Rec ID filters. 

i. To expand the filter so that more than one ID can be entered, click the   

adjacent to the ID filter.  A text box will appear as shown below. 

 

ii. Type the numeric portion of the ID and press Enter (the AFL- and REC- prefixes 

may be entered, but are not required).  You may enter as many IDs as you wish.     

d. To select a set of AFLs based on event date, you may specify a closed or open-ended 

date range using one or both of the Event Date filters.   

i. To select AFLs with an event date on or after a particular date, enter the date in 

Event From. 

ii. To select AFLs with an event date prior to and including a particular date, enter 

the date in Event To. 

iii. To include AFLs within a specified range of years but with unknown month and/or 

day, check the month and/or day boxes in the Show unknown dates section.   

iv. To include AFLs with unknown year, check the year box in Show unknown dates 

section.    

v. To review a list that only includes AFLs with unknown event dates, enter a future 

date in Event From and check the year box in the Show unknown dates 

section. 

e. To search for a specific AFL by patient name, enter text into the Last Name and/or 

First Name filters. 

f. To select by facility, use the  lookup to specify an ID in the Facility filter.  If you are 

creating a group of AFLs you must select AFLs for a single facility. 
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g. To search by region, select a value in the Region filter.   This filter is only displayed if 

your registry manages data for multiple regions. 

3. Click Apply. 

4. Select the AFL(s): 

a. To select a single AFL, check the box to the left of the Task ID. 

b. To select two or more AFLs, use one of the following methods: 

i. To select specific AFLs, check the box to the left of each AFL ID.  You can only 

select AFLs on the same page with this method.  

ii. To select all AFLs displayed on the current page, check the box on the top left of 

the page, adjacent to the AFL ID column heading. 

iii. To select all tasks on all pages of the filtered list, click Modify All and skip ahead 

to Step 6.   

5. Click Modify. 

6. You may set the following fields for the selected AFLs.  Only specify a value for a field if 

you wish to change that field for the selected AFLs.  If you leave a field blank then each 

AFL will retain its current value for that field. 

a. Status – AFLs that require processing should be set to Open.  If no further processing is 

required, set this field to Closed. 

b. Result - use an AFL’s result field to track the determination coded by the abstractor on 

the Abstracting Assignments report.  The valid values for this field are listed below.  

Registry policies based and tracking procedures should determine how this field is 

populated and maintained.  In SEER*DMS, the Abstracted and Not a Reportable Cancer 

values involve special processing as noted below. 

c. Group Action – To create a new group containing the selected AFLs, set Group Action 

to Group.  If an AFL is currently in a group, it will be re-assigned to the new group.  To 

remove the current group ID and allow the AFls to be re-assigned at a later time, set 

Group Action to Ungroup. 

d. Send Letter – this flag is not used by SEER*DMS but may be referenced by external 

reports that create letters requesting additional information from a physician or 

reporting facility.  You may filter by this flag on the AFL Manager page. 

7. To change a limited number of the AFLs, enter a value in Maximum Number to Modify.  

Using this method, you cannot control the specific AFLs that are modified.  This provides a 

convenient mechanism for limiting the number assigned to a group and should not be used 

for other purposes. 

Creating a CTC from a Non-abstract Record 

Requires system permission:  rec_build_cfo 

If you determine that a case should be submitted to SEER despite the fact that an abstract is 

currently unavailable, you may use the record editor to create a CTC from the non-abstract record.  

This feature is available for reportable casefinding, death certificate, and short health records.  (In 

this context, casefinding includes any record processed in the workflow as “Casefinding”.  The 

specific record types will vary by registry and may include HL7 and other import types).  If the 
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record is not linked to an existing patient set, you may create a new patient set.  If the record is 

linked to a patient set but not to a CTC, you may create a new CTC within the patient set. 

Alternatively, system tasks are available to auto-build batches of cases from non-abstract records 

as described in Chapter 27:  System Administration.  The Build DCO, Build CFO, Build SHO system 

tasks incorporate reportable, unlinked records into the Patient Set data as new Patient Sets or new 

CTCs for existing Patient Sets.  

To create a Patient Set from a non-abstract record: 

1. Open the record in the record editor. 

2. If the record is a casefinding or short health record, select Build Patient Set from the 

record menu.  This menu item is only available on unlinked casefinding records and can 

only be seen by users with the rec_build_cfo permission. 

3. If the record is a death certificate record, select Build Patient Set from the record menu.  

These menu items are only available on unlinked death certificate records and can only be 

seen by users with the rec_build_cfo permission.  

4. Click OK to confirm. 

5. SEER*DMS will create an automated workflow task to create the patient set.  When the 

task completes, a Visual Edit Patient Set task for the patient set will be assigned to you. 

To create a CTC from a non-abstract record: 

1. Search the database for the record or its associated patient set.  You may enter the 

Patient Set or Record ID into the quick search, or click View > Patients to use the Patient 

Lookup.  (See Chapter 20:  Searching for Patients and Records.) 

2. Verify that the record is not already linked to a CTC.  If it is linked at the patient level, you 

may proceed.   

3. Click the ID of the record in the patient set navigation box.   

4. Select Move To > New CTC from the record’s menu.   

5. SEER*DMS will create a new CTC; you may proceed with visual editing. 
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Casefinding Reports 

The following reports are available for monitoring the completeness of casefinding.  Instructions for 

generating reports are provided in Chapter 24: Creating Reports and Extracting Data.  Consult your 

IT staff to determine if other, external casefinding reports are available at your registry.   

Report ID Title Description 

RPT-003A Tasks for Unlinked 

Records with Closed AFLs 

This report lists workflow tasks related to AFLs that 

were manually closed. 

RPT-015A Record Counts  by 

Abstractor 

Number of records abstracted by each abstractor for a 

specified period of time. 

RPT-017A CTC Frequencies by 

Month of Diagnosis 

CTC counts by month of diagnosis for three years. 

RPT-018A CTC Frequencies by SEER 

Site Recode 

CTC counts by SEER site recode for a two-year period. 

RPT-019A Death Clearance 

Summary 

A listing of records that are potential DCOs; includes 

each record’s status related to the workflow and AFLs. 

RPT-024A Abstractor’s Report of 

Active Cases 

A reference sheet for abstractors showing the active 

cases in the database for a facility.   

RPT-067B Frequency of Records for 

Build CFOs Task 

Number of records to be considered by Build CFOs 

task. 

RPT-067C Candidate Records for the 

Build CFOs System Task 

A list of the records that will be used by the Build 

CFOs system task. 

RPT-068B Frequency of Records for 

Build DCOs Task 

Number of records to be considered by the Build DCOs 

system task. 

RPT-068C Candidate Records for the 

Build DCOs System Task 

A list of the records that will be used by the Build 

DCOs system task. 

RPT-089B Frequency of Records for 

Build SHOs Task 

Number of records to be considered by the Build SHOs 

system task. 

RPT-089C Candidate Records for the 

Build SHOs System Task 

A list of the records that will be used by the Build 

SHOs system task. 

RPT-080A Abstract Facility Leads 

Closed Manually 

List of the AFLs which were closed manually on a 

specified day. 
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